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About This Guide

This document contains installation and licensing guidelines to enable you to
install the following products on a Windows platform:

* PTC Arbortext Advanced Print Publisher — Desktop
* PTC Arbortext Advanced Print Publisher — Server
* PTC Arbortext Advanced Print Publisher — Enterprise

Organization of This Guide

This reference is divided into three main sections:

Introduction to PTC Arbortext
Advanced Print Publisher Installation
on page 9

A summary of the information you
need to ensure that you are fully
prepared to commence installation of
APP

Installing PTC Arbortext Advanced
Print Publisher on Windows on page 15

Full instructions to walk you through
installation of the Desktop and
Enterprise versions of APP

Configuring PTC Arbortext Advanced
Print Publisher — Enterprise on
Windows on page 35

Instructions for changing the user
accounts used by PTC Arbortext
Advanced Print Publisher - Enterprise
Schedulers and Agents

Licensing PTC Arbortext Advanced
Print Publisher on Windows on page 25

A summary of the APP licensing
process




Related Documentation

For more information refer to the following documentation, found in the PTC
Arbortext Advanced Print Publisher Help Center. Help Center includes both web-
based HTML and PDF versions of the information and is accessed from the Help »
Help Center menu.

Documentation Description

PTC Arbortext Advanced Print Information about new, changed, and
Publisher Release Notes deleted features in this APP release.
PTC Arbortext Advanced Print An overview of APP and its underlying
Publisher User's Guide objects and processes.

Technical Support

Contact PTC Technical Support using the PTC website, email, phone, or fax if
you encounter problems using your product or the product documentation.

Use the Contact Support links on the PTC website at:
http://www.ptc.com/support/

The PTC website also provides a search facility for technical documentation of
particular interest. To access this search facility, use the URL above and select
Search Our Knowledge.

You must have a Service Contract Number (SCN) before you can receive
technical support. If you do not have an SCN, contact PTC Maintenance
Department using the contact instructions found in your Customer Support Guide.

Documentation for PTC Products

You can access PTC product documentation using the following resources:
*  Online Help

Click Help from the user interface for online help available for the product.
* Reference Documents

Individual product manuals are available from the Reference Documents link
of the PTC website at the following URL:

http://www.ptc.com/support/
* Help Center

Help Centers for the most recent product releases are available from the PTC
website at the URL given below. Select the Support Center for the relevant
products to access the Help Centers link.

http://www.ptc.com/support/
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You must have a Service Contract Number (SCN) before you can access the
Reference Documents or Help Centers links. If you do not have an SCN, contact
PTC Maintenance Department using the contact instructions found in your
Customer Support Guide.

Global Services

PTC Global Services delivers the highest quality, most efficient and most
comprehensive deployments of the PTC Product Development System including
PTC Creo, PTC Windchill, PTC Arbortext, and PTC Mathcad. PTC’s
Implementation and Expansion solutions integrate the process consulting,
technology implementation, education and value management activities customers
need to be successful. Customers are led through Solution Design, Solution
Development and Solution Deployment phases with the continuous driving
objective of maximizing value from their investment.

Contact your PTC sales representative for more information on Global Services.

Comments

PTC welcomes your suggestions and comments on our documentation. You can
submit your feedback to the following email address:

arbortext-documentation@ptc.com

Please include the following information in your email:

e Name
* Company
*  Product

* Product Release

* Document or Online Help Topic Title

» Level of Expertise in the Product (Beginning, Intermediate, Advanced)
» Comments (including page numbers where applicable)

Documentation Conventions
This guide uses the following notational conventions:

* Bold text represents exact text that appears in the program's user interface.
This includes items such as button text, menu selections, and dialog box
elements. For example,

Click OK to begin the operation.

* A right arrow represents successive menu selections. For example,

Choose File » Print to print the document.
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Monospaced text represents code, command names, file paths, or other
text that you would type exactly as described. For example,

At the command line, type version to display version information.

Italicized monospaced text represents variable text that you would
type. For example,

installation-dir\custom\scripts\

Italicized text represents a reference to other published material. For example,

If you are new to the product, refer to the Getting Started Guide for basic
interface information.
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In this chapter you will find all the information you need to ensure that you are
fully prepared to commence installation of your PTC Arbortext Advanced Print
Publisher product.



Product Information

PTC Arbortext Advanced Print Publisher is an automated publishing engine that
handles complex layout requirements and supports post-composition changes to
content, formatting and layout.

This guide contains installation information for the PTC Arbortext Advanced Print
Publisher product suite. Before proceeding with this installation, we recommend
you read the PTC Arbortext Advanced Print Publisher Release Notes for this
release. The document can be found at the following locations:

* The appprodrel.pdf file in the Documentation directory of the CD-ROM
or web download zip

* The Reference Documents link on the Arbortext section of the PTC Support
site, at www.ptc.com/support

Licensing

PTC Arbortext Advanced Print Publisher (APP) uses the FLEXnet licensing
system. This mirrors the system used to license other PTC Arbortext products.
You can obtain a FLEXnet license from the Arbortext section of the PTC support
site at www.ptc.com/support/.

You will need either a node-locked FLEXnet license or a floating FLEXnet license
to run PTC Arbortext software. Licenses are available online for customers
covered by an active maintenance agreement. You must have a PTC online
account and a Customer Number to get a license.

See Licensing PTC Arbortext Advanced Print Publisher on Windows on page 25
for information on obtaining a license.

Note that dongles and Arbortext License Manager are not supported on any APP
version.

Distribution

There are two archives available for installing this release:

Product Archive

This archive includes all files necessary to install the PTC Arbortext Advanced
Print Publisher (APP) product.

You have either a download archive called filename-release.no
datecode bit.no-product.zip ora CD-ROM for the PTC Arbortext
Advanced Print Publisher product suite.

Where:
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* release.no is the major release of APP you wish to install, e.g. 11.1
* datecode is the specific release of APP you wish to install, e.g. F0O00, M010

* bit.no specifies whether you are installing a 32-bit (Win32) or 64-bit (Win64)
version of the product

» product indicates the product variant you are installing, i.e. Desktop or
Enterprise

For example, the file MED-60915-CD-111 F000 Win32-Desktop.zip
contains files to install the 32-bit version of the 11.1 F0OO0O release.

The top level directory contains the program file ArbortextAPP [bit no]
[product] release.no datecode.exe program for installing APP.

Media Archive

This archive includes all files necessary to install additional media to accompany
an PTC Arbortext Advanced Print Publisher installation — documentation, Help
Center, and libraries.

You have a download archive called filename-release.no_
datecode.zip.

PTC Arbortext Advanced Print Publisher
Components

The following list describes the components of the PTC Arbortext Advanced Print
Publisher product suite:

PTC Arbortext Advanced Print Publisher — Desktop
Interactive user interface for template development and manual adjustment of
the composed document.

PTC Arbortext Advanced Print Publisher — Server
An PTC Arbortext Advanced Print Publisher option that can be licensed to
support certain very specific automated workflows that cannot be supported
via PTC Arbortext Advanced Print Publisher — Enterprise.

If you are upgrading from a previous version of PTC Arbortext Advanced
Print Publisher — Server, install PTC Arbortext Advanced Print Publisher —
Desktop and then obtain and apply the PTC Arbortext Advanced Print
Publisher — Server license key.

PTC Arbortext Advanced Print Publisher — Enterprise
Publishing engine that detects, schedules, and runs APP jobs, providing an
unattended publishing solution capable of running on multiple client
machines.

Introduction to PTC Arbortext Advanced Print Publisher Installation 11



System and Software Requirements

Disk Space

* PTC Arbortext Advanced Print Publisher — Desktop installation: 167 MB
(approx)

* PTC Arbortext Advanced Print Publisher — Enterprise installation: 2.2 MB
(approx)

Minimum Requirements

Pentium III processor (or equivalent), 2.0 GHz, 512 MB RAM, 50 MB disk space,
plus 1 GB additional space for production output.

Recommendations

Pentium IV processor (or equivalent), 3.0 GHz, 1 GB RAM, 50 MB disk space,
plus 2 GB additional space for production output.

Evaluate your site's production environment for factors that may affect site
adjustments to the requirements and recommendations, such as number and size of
documents, number and size of graphics and network traffic, as all have an impact
on the optimization of disk space, memory, throughput and output.

Platform Requirements — Windows

* PTC Arbortext Advanced Print Publisher — Desktop - Windows XP,
Windows Vista, Windows 7, Windows Server 2003, Windows Server 2008,
Windows Server 2008 R2

* PTC Arbortext Advanced Print Publisher — Enterprise - Windows XP,
Windows 7, Windows Server 2003, Windows Server 2008, Windows Server
2008 R2

Platform Requirements — Other

Contact your sales representative for information on Solaris, Linux or other UNIX
platforms.

Localization

You may display the APP interface in languages other than English — the
following six language versions of the interface are included:

* English (UK)
* English (US)

* French

12 Installing PTC® Arbortext® Advanced Print Publisher™



*  German
* Simplified Chinese
* Japanese

There are three ways in which a language option can be applied, all based around
the same main command, i.e.-G:, and the same language parameters:

uk
English (UK) — default

us
English (US)

de
German

fr
French

cn
Chinese

ja
Japanese

For example, -G : de will activate the German language version.

1. Command line: simply enter the command, as shown above, in the APP
command line.

2. On startup: add the command, as shown above, to startup file sargsw. 3ad.
This file will need to be created if it does not already exist.

3. Shortcut: create a shortcut for APP on your desktop as usual, then edit the
properties of the shortcut to include the command and relevant parameter after
the name of the executable in the Target field.

For example, to activate the French interface the target might read "C: \
Program Files\PTC\Arbortext Advanced Print Publisher\
APP.exe" -G: fr. Note that a space separates the second double quote and
the command.

Technical documentation and supporting literature is provided in English (UK)
only for all 11.1 releases.

Learning More About PTC Arbortext
Advanced Print Publisher

Once you have installed PTC Arbortext Advanced Print Publisher — Desktop,
documentation is available from several locations:

Introduction to PTC Arbortext Advanced Print Publisher Installation 13



* The Help menu option of the APP interface: click the Help Center button to
access online help and product documentation

» The Start » Programs » PTC menu in a Windows installation
* The APP-path\documentation directory
The following product documentation is available from these locations:

* Help Center: online information about APP's macros and PlIs, plus reference
manuals and further reading on a series of topics

* PDF documents:
O PTC Arbortext Advanced Print Publisher Release Notes (appprodrel.pdf)
O [Installing PTC Arbortext Advanced Print Publisher (appinstall.pdf)

Once you have installed PTC Arbortext Advanced Print Publisher — Enterprise,
documentation is available from the Start » Programs » PTC » Arbortext Advanced
Print Publisher » Documentation menu, and from the APP-path\docs\
index.html directory.
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You can install any of the following products:
* PTC Arbortext Advanced Print Publisher — Desktop

Installation instructions can be found in Installing PTC Arbortext Advanced
Print Publisher — Desktop on page 16.

* PTC Arbortext Advanced Print Publisher — Server
If you are upgrading from a previous version of PTC Arbortext Advanced
Print Publisher — Server, follow the instructions for PTC Arbortext Advanced

Print Publisher — Desktop, and then obtain and apply the relevant license for
PTC Arbortext Advanced Print Publisher — Server.

* PTC Arbortext Advanced Print Publisher — Enterprise

Installation instructions can be found in Installing PTC Arbortext Advanced
Print Publisher — Enterprise on page 19 .
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Preparation

You must install PTC Arbortext Advanced Print Publisher (APP) into a separate
directory from any other 3B2 or APP installation. You are not permitted to run
F000 and Mxxx datecode releases of the same major release concurrently.

You may run this release of APP alongside a previous release, for example release
10.0 or 11.0.

Check the directories of your current installation for files that you may have
customized. You may want to save them to reuse with your upgraded version. Be
sure to copy them to a safe location before proceeding with the installation.

Perl Version Required for this Release

You must install version 5.8.9 of Perl to support this release.

Installing PTC Arbortext Advanced Print
Publisher — Desktop

~ Note

If you are upgrading a previous version of PTC Arbortext Advanced Print
Publisher — Server, follow these instructions for the PTC Arbortext
Advanced Print Publisher — Desktop. You must then obtain the necessary
PTC Arbortext Advanced Print Publisher — Server license to enable the
server functionality.

To install PTC Arbortext Advanced Print Publisher — Desktop

1. Ifyou are installing from CD-ROM, insert the CD-ROM into your CD-ROM
drive.

If you are installing from a downloaded zip file, unzip the product archive file
to a temporary directory of your choice. After you have extracted the file
contents, the directory structure for the extraction and for the CD-ROM will
be the same.

2. Find and run ArbortextAPP [bit.no] [product] [release.no]
[datecode] .exe. When the installer starts, you will be presented with a
welcome screen that confirms the product that will be installed.

If you are upgrading your installation of PTC Arbortext Advanced Print
Publisher — Server, you should install PTC Arbortext Advanced Print
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5.

Publisher — Desktop and then obtain the applicable Server license to run it in
server mode.

Click Next to continue.

The License Language dialog box allows you to choose the language version
of the license agreement you’d like to see. Note that the installer itself will
always remain in English, regardless of the language you select here. Make a
selection then click Next to continue.

Confirm that you accept the terms in the software license agreement, then
click Next to continue.

In the Setup Type dialog box, choose either Complete or Customn.
» Ifyouchoose Complete, click the Next button and proceed to step 6.

~ Note

If you wish to change the default installation path, select the Custom
install option. You can change the installation path on the Custom
Setup dialog box.

» Ifyou choose Custom, continue with the following:

a. Click the Next button to choose the components for installation.

b. From the Custom Setup dialog box, select the product components you
want to install. If this is the first installation, all components are
selected by default. You can change the default installation path.

~! Note

If you have an existing PTC Arbortext installation, you must install
this release into a different directory. You are not permitted to run
the FOOO and Mxxx datecode releases of the same major release
concurrently.

Verify your choices and click the Next button to proceed.

Choose whether to send shortcuts for the product to the Start Menu and the
Desktop.

Click Install to install the software on your computer.

In the Ready to Install the Program dialog box, click Install to begin

Installing PTC Arbortext Advanced Print Publisher on Windows 17



installation, or Back to review any of the choices you’ve made during the
setup process.

9. The Installing PTC Arbortext Advanced Print Publisher dialog box will provide

information on the status of your installation. You will see the InstallShield
Wizard Completed dialog box when the installation is completed. Click Finish.

Once the product is installed, you must ensure that you have write access to all the
installed files so you can modify them if necessary. PTC cannot guarantee that all
files in the install directory are write-enabled. Make sure that:

* Permissions on the install directory allow you to modify all of the files it
contains

* You have not installed APP in a location that is protected by Windows

To make changes to installation or install additional media

You may want to update your installation, for example by installing additional
product variants or add-on libraries, or accessing documentation. Follow the
process below:

* Unzip the media archive file to a temporary directory of your choice.

* Find and run Setup.exe. When the installer starts, you will be presented
with a welcome screen from which you can make a selection:

O Install an additional APP product variant — choose the Install... option,
then Advanced Print Publisher (32-bit)... or Advanced Print Publisher (64-
bit)...

O Install add-on libraries — choose the Install... option, then Add-on
Libraries...

O Install FlexLM License Server — choose the Install... option, then FlexLM
License Server

O Access APP Help Center or PDF documentation — choose the
Documentation... option
* Make your required selection. Next steps depend on the option you choose
here:

O Install 32-bit version of APP Desktop or APP Enterprise — choose the
Advanced Print Publisher (32-bit)... option. Follow the steps in To install

PTC Arbortext Advanced Print Publisher — Desktop on page 16 to
complete the installation.

O Install 64-bit version of APP Desktop or APP Enterprise — choose the
Advanced Print Publisher (64-bit)... option. Follow the steps in To install
PTC Arbortext Advanced Print Publisher — Desktop on page 16 to
complete the installation.
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O Installing add-on libraries — select the required library to invoke its set up
wizard. Follow the steps in Installing Add-on Libraries on page 22 to
complete the installation.

O Installing FlexLM License Server — select the 32-bit or 64-bit version to
invoke a PTC.Setup wizard, which will guide you through the install
process.

* Choose Exit in the welcome screen once you have finished your installation.

Licensing PTC Arbortext Advanced Print Publisher — Desktop

Refer to Licensing PTC Arbortext Advanced Print Publisher on Windows on page
25 for information on licensing.

Location of APP Error Log File on Startup

The error log file serrlog. 3at is usually created in the APP install directory
on startup. If this fails or is not possible, the log file will now be created in the
Windows temp directory indicated by the TEMP environment variable.

This behavior is expected with Windows Vista and later.

Installing PTC Arbortext Advanced Print

Publisher — Enterprise

PTC Arbortext Advanced Print Publisher — Enterprise consists of three parts: a
Scheduler, Agents and a monitoring tool. You will need to choose how to deploy
the scheduler and the agents. The monitoring tool does not affect deployment
strategy.

The simplest option is to install the PTC Arbortext Advanced Print Publisher —
Enterprise components as a standalone installation on a single computer. Choose
this option if the resources required by the composition jobs are all located on the
same computer. If the standalone installation requires access to resources available
on another computer in the domain you will need to perform some post-
installation configuration.

Choosing the Components

There are three basic components:

Monitor
A client user interface to the Scheduler that provides control over the
Scheduler and displays useful information about it. The Monitor can be useful
on any machine, but you can use a Monitor installed on another computer to
connect to the Scheduler you are installing on this computer. You can choose
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not to install the Monitor at this time and then run this installation from
another machine to install it there.

Scheduler
A server component for managing Agents.

Agent
An Agent is launched locally or remotely by the Scheduler to control instances
of PTC Arbortext Advanced Print Publisher running in OCX mode.

Network Considerations

If your Scheduler or Agents are running on, or require access to, another
computer, you need to configure user accounts and the COM/DCOM security
settings on the computers involved.

PTC Arbortext Advanced Print Publisher — Enterprise and the installer together
can perform some of the tasks involved if the network uses the Windows Domain
model. For each Scheduler and Agent, you need to set the user account and
DCOM permissions. Other network configurations are not supported.

Installation Procedure
Before proceeding, be aware of the following:

* You must have Administrator privileges to install PTC Arbortext Advanced
Print Publisher — Enterprise successfully.

* The PTC Arbortext Advanced Print Publisher — Desktop OCX version must
also be installed on any computer that will be running an PTC Arbortext
Advanced Print Publisher — Enterprise Agent.

* PTC Arbortext Advanced Print Publisher — Enterprise installs the Scheduler
as a Windows Service program.

To Install PTC Arbortext Advanced Print Publisher — Enterprise

1. If you are installing from CD-ROM, insert the CD-ROM into your CD-ROM
drive. If the install program starts automatically, skip to step 3.

If you are installing from a downloaded zip file, unzip the file to a temporary
directory of your choice. After you have extracted the file contents, the
directory structure for the extraction and for the CD-ROM will be the same.

2. At the top level directory, find and run setup . exe. When the installer starts,
you will be presented with a box to choose a language. This will determine
which version of the license agreement to display. Note that the installer itself
will always remain in English, regardless of the language you select here.
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3. On the first screen, choose Install. You'll be presented with the following
product choices:

* PTC Arbortext Advanced Print Publisher — Desktop
* PTC Arbortext Advanced Print Publisher — Enterprise
* Add-on Libraries

4. From the product list, choose PTC Arbortext Advanced Print Publisher —
Enterprise.

5. Accept the Software License Agreement.

6. On the next dialog box, choose the components you want to install:

*  PTC Arbortext Advanced Print Publisher — Enterprise Scheduler
*  PTC Arbortext Advanced Print Publisher — Enterprise Agent
*  PTC Arbortext Advanced Print Publisher — Enterprise Monitor

For a standalone installation, choose all the components. However, for a
distributed deployment, you may be installing on a machine that only needs
the Scheduler and the Agent components. Verify your choices and click the
Next button to proceed.

7. In the Install Location dialog box, it is recommended that you accept the
default path for the installation directory. Verify the path and then click the
Install button to install the software on your computer.

8. Click Install to install the software on your computer.

Once installation is complete, you will need to set up the licenses for your
installation. Refer to Licensing PTC Arbortext Advanced Print Publisher on
Windows on page 25 for information.

When you finish installation and licensing, be sure to proceed to Changing the
Scheduler User Account on page 36 for information on how to configure the
Scheduler for your installation.

Libraries

The PTC Arbortext Advanced Print Publisher installation offers a set of optional
tools and resources you can use in your production environment. Refer to
Installing Add-on Libraries on page 22 for information on how to install these
libraries.
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Installing Add-on Libraries
1.

On the welcome screen of the setup program invoked from the media archive,

you'll be presented with the product options available for install. Choose
Install... then Add-on Libraries. From the list, click the tool or resource you

want to install.

SRS

Choose the language of the license agreement. Click Next.
Accept the license agreement and click Next.

Change the directory location of the install if required.
Click the Install button to proceed with the installation.

After the setup is completed, you can check the box for Show Manual to read

the documentation. Click Finish to exit the installation program.

The following tools and resources are available from the installation program
under Add-on Libraries. Note: the version numbers detailed below relate to this

release of PTC Arbortext Advanced Print

Publisher. Updates to libraries may be

included with subsequent maintenance releases of the product.

Supported tools and resources

Component

Description

APP Markup Library v2.98f

Set of HTML table, CALS table,
MathML and character entity tags

APP Markup Library Test Suite v1.02

Test suite for the APP Markup Library

Perl Library v3.06

Collection of Perl functions to aid
productivity for template developers.

Development Assistant v2.04

Collection of tools to aid productivity
for template developers.

Change Language Library v1.09

Switch the display language for menus
and dialog boxes among English,
American, German and French

Barcode Library v1.03

Auto-generate barcodes for inclusion in
documents

Macro Timer v1.01

Timers for macros such as tformat
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The following unsupported additional tools and resources are also available.
Please contact PTC product support at www.ptc.com/support for further

information.

Unsupported additional tools and resources

Component

Description

Watcher

Monitor a directory and process control
files from within this directory. Also
includes a basic logging facility and a
test suite.

Dieckmann

Edit and modify Dieckmann's
exception dictionaries

Superprint

Interface to save tags to a file system,
browse folders and display control files.
Also allows users to write and save
control streams used by external
programs.

Snippets

Store code fragments or any other data
so they can be re-used and re-inserted
at any time in any template.

SaveState

Perl package to save and restore the
complete PTC Arbortext Advanced
Print Publisher environment, current
Edit Bar settings, and current settings
of a specific stream.

Tie::TagHash

Access to APP tags from Perl scripts
using variables.

Tie::StringHash

Access to APP strings from Perl scripts
using variables.

LoadObjects Scan a given stream and import all
rasters and/or objects by reading
predefined markup and attributes.

CreateFrame Create frames with all possible

properties using Perl.

Template::Compare

Compare two templates and libraries.

Shell Extension Handler

Opena .3f or . 3d file using a
specific version of PTC Arbortext
Advanced Print Publisher.
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Program Group for PTC Arbortext
Advanced Print Publisher — Desktop

Once you have installed PTC Arbortext Advanced Print Publisher — Desktop, the
program group on the Windows Start menu contains the following shortcut links
for the product:

* Advanced Print Publisher program

* Documentation, which contains links to the Help Center information source
and product documentation in PDF form

Program Group for PTC Arbortext

Advanced Print Publisher — Enterprise

Once you have installed PTC Arbortext Advanced Print Publisher — Enterprise,
the program group on the Windows Start menu contains the following shortcut
links for the product:

* Documentation, which links to the PTC Arbortext APP-E HTML index page.

*  Monitor
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PTC Arbortext Advanced Print Publisher is licensed via the FLEXnet licensing
system, in accordance with other PTC Arbortext products. You will need to obtain
and install new licenses to run this release. The use of dongles is not supported.

Refer to License Support in the Arbortext section of the PTC support site (www.
ptc.com/ support) to obtain, return, or track licenses.
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License Types

Once you have complete your PTC Arbortext Advanced Print Publisher
installation, you must setup licensing for the product. You will need to obtain a
new license for this release. Licenses issued for previous releases will not work
with this release. This release uses licensing information generated by the
FLEXnet licensing system. You will be able to use the license generated for this
release with the next major release.

There are three basic types of FLEXnet license:

* Node-locked license for use on a single computer. This type of license is
usually obtained by the end user.

This is similar in concept to a fixed license generated under the previous Elan
licensing system.

Note that you will only be permitted to run a single APP instance if you
choose a node-locked license.

* A floating license pack for a single computer that will be serving floating
licenses to end users. This type of license is usually obtained by a system
administrator.

A floating license is similar in concept to a concurrent license generated under
the previous Elan licensing system.

* A floating license pack for a set of three servers (called a triad license server)
that will be serving floating licenses to end users. This type of license is
usually obtained by a system administrator.

A triad license server is similar in concept to a redundant license server under
the previous Elan licensing system.

You will need either a node-locked or a floating license to run PTC Arbortext
Advanced Print Publisher — Desktop. PTC Arbortext Advanced Print Publisher
— Enterprise only supports a floating license on a license server. This is required
to support the counted number of additional agents. Licenses can be obtained from
the License Support page in the Arbortext section of the PTC Support site, at
www.ptc.com/support. Licenses are available online for customers covered by an
active maintenance agreement. You must have a PTC online account and a
Customer Number to get a license.

Refer to Obtaining Licenses on page 29 for information on how to obtain licenses.

Node-locked Licenses

A node-locked license file is a local license file that allows PTC Arbortext
Advanced Print Publisher to be run on an authorized computer. The license file is
stored on the computer on which the software is run. License files are generated
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from a host ID code unique to each system. You can only run one instance of PTC
Arbortext Advanced Print Publisher on one authorized computer with a node-
locked license.

The PTC licensing web site uses your PTC Arbortext Advanced Print Publisher
version, customer number, and Host ID code to generate a node-locked license.

Floating Licenses

Floating licenses are made available from a license server on a network to a set of
users running the software. A license server allows multiple computers (license
clients) on the network to run PTC Arbortext Advanced Print Publisher
concurrently. The client computer running PTC Arbortext Advanced Print
Publisher must specify the port and server named of the license server to obtain a
floating license. If a license is available the user is allowed to run the software.

The PTC licensing web site uses the PTC Arbortext Advanced Print Publisher
version, customer number, and Host ID code of the license server or servers to
generate a floating licenses.

The system administrator must install the FLEXnet license management software
and set up the necessary floating licenses before users can run the PTC Arbortext
Advanced Print Publisher product. Please refer to Installing a License Server on
page 31 for information.

A single server configuration uses only one computer as the license server. Your
site can implement server redundancy by using a triad license server. A triad
server configuration uses three license servers. A triad server provides a fallback
mechanism to obtain licenses even if the main server goes down. Because a
majority rule is in effect, at least two of the servers must be running for the triad
server to function.

When you run software with a floating license, you may need to specify the
communications port number and license server name the first time you run it. If
prompted, enter the server information in the form port@servername, for example
6789@aberdeen.

You should verify the following with your system administrator:

» That the FLEXnet license server software has been installed and configured on
the licenser server machine

*  The port number and server name of the license server on your network

Licensing Summary

PTC Arbortext Advanced Print Publisher will search for a license the first time it
is run. You will be prompted for license information if a valid license is not found.
Note that this will not happen if licensing information is deployed to your system
by a system administrator.
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PTC Arbortext Advanced Print Publisher looks for the system environment
variable PTC D LICENSE FILE on page 31 automatically when it starts. This
variable setting provides the path to one of the following to find licensing details:

*  Your node-locked license file

* A port@servername specification, from where your software can retrieve a
floating license.

If PTC_D LICENSE FILE does not exist or has an incorrect value, a licensing
error is reported and you will need to specify licensing information as instructed.

Licensing Prerequisites
To configure licenses and obtain a license pack file, you need the following:

*  Web access and a PTC customer account with an active maintenance
agreement. You can register at www.ptc.com/support

*  Your customer login, password, and customer number

* The Host ID unique to the computer. You can access this information in any of
the following ways:

O By referring to the Licensing Error dialog box that appears if PTC
Arbortext Advanced Print Publisher can’t obtain a license the first time
you run it. The Host ID code will appear here.

© By running cpu_id.exe from a Windows command prompt (available
from the £1ex1m directory on the installation DVD or download zip, or
from the PTC Support site).

O By using one of the options described in the following web page:
http://www.ptc.com/appserver/wems/standards/freefull _cskdb.jsp?im_
dbkey=90575&icg_dbkey=900

Prerequisites for Licenses

For each copy of PTC Arbortext Advanced Print Publisher you plan to install, you
need to carry out the following tasks:

* Request a license on the PTC Support site at www.ptc.com/support. Have your
customer login, password, customer number, and Host ID for the computer at
hand.

If you are setting up a floating license server, be sure you have the Host ID
and server name of the license server or servers.
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See Troubleshooting Licensing Issues on page 32 for further information.

* Receive the license pack containing your configured license(s). Save the
license pack to a folder on the computer where you will install your licenses.

See License Packs on page 30 for further information.

Prerequisites for License Servers

The following prerequisites apply if you plan to install a license server to provide
floating licenses:

» The floating license server must have the FLEXnet license management
software installed.

*  Your PTC Arbortext Advanced Print Publisher software must have a working
network connection to the license server and specify the port number and
server name to request licenses.

Refer to Installing a License Server on page 31 for further information on setting
up a license server.

Obtaining Licenses

Go to the PTC Support site at www.ptc.com/support to request and configure
licenses. Note that the support site might not offer license keys for all possible
customer requests. Request assistance on the PTC Support web site, if necessary,
regarding any of the following:

* Modification of an existing license key to add new floating licenses to an
existing server

» Extension of a temporary license for evaluation
* Generation of licenses for triad server configurations

You can submit a request for assistance on the PTC Support site. Create a new
case on the Contact Support page. You can also contact PTC License Management
Support by telephone. See www.ptc.com/olm/contacts for a list of contact
numbers.

On the PTC Support site, the licensing web tool steps you through the process of
configuring your software to your hardware. You will use the PTC License
Landing Page to configure the software licenses.

Refer to Licensing Prerequisites on page 28 for information you will need to have
to hand.

1. Go to the PTC Support site at www.ptc.com/support.

2. Move to the Arbortext section.
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3. Choose Arbortext License Support and log into your PTC account when
prompted. You will need your login name, password, and customer number.

4. Choose Arbortext Advanced Print Publisher from the Product
Family field and the required release from the Version field. The Hardware
Selection form appears.

5. Enter your computer’s Host ID in the PTC Host ID field. If your computer is
already on the system, you can browse for it.

Enter the name of your computer in the Host/Triad Name field.
The information in the fields should identify one of the following:

* A single computer for a node-locked license
* A single computer that will be serving floating licenses to end users

* A set of three computers (a triad license server) that will be serving
floating licenses to end users and providing server redundancy

Click Continue.

If your Host ID is not in the PTC licensing system, you will be asked to enter
an installation address and contact that will be associated with the Host ID.

8. Confirm the combination of software and hardware for your license, then click
Get License. You will receive a call number for confirmation of the request.

9. The license transaction is processed and the license pack file will be emailed
to you.

License Packs

Once you have completed a license request, you will receive a license pack email
from LM@PTC.com. The email includes a text file attachment with a filename in
the form 1m xxxxxxxx standard.txt. The email message may contain
licensing instructions for other PTC software products, depending on the content
of the license pack file. Save the attached licensed pack to a directory and note its
location.

If you are using a locked license, you will be prompted to enter the license file
location the first time you run your PTC Arbortext Advanced Print Publisher
software. The information is stored in the PTC_D LICENSE FILE environment
variable (refer to The PTC D LICENSE FILE Environment Variable on page 31
for further information).

If you will be using a floating license but you are not configuring a license server,
you will not be obtaining a license pack from PTC. You will instead enter the port
number and server name of the license server the first time you run the software.
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Installing a License Server

If you are upgrading from a previous release of PTC Arbortext Advanced Print
Publisher for the first time, and your installation uses floating licenses or a
combination of node-locked and floating licenses, your system administrator will
need to install the FlexNet License Server. If a user attempts to use an upgraded
version of the PTC Arbortext Advanced Print Publisher software with an
unsupported license server, or an invalid license file, or a dongle, the Licensing
Error dialog box reports the error and prompts for valid information. If the
FlexNet license server is already installed, it may not need to be upgraded when
the PTC Arbortext Advanced Print Publisher software is upgraded. Refer to the
Release Notes for the particular release for more information.

The FlexNet license server system is documented in the FLEXnet Licensing End
User Guide. This guide explains the basics of FlexNet floating (network)
licensing, gives an overview of the FlexNet licensing components, and provides
details on managing floating licenses for administrators. This guide is available
from the f1ex1m directory of your PTC Arbortext Advanced Print Publisher
installation distribution (from zip or DVD download). It is also available from the
Reference Documents page of the PTC Support site at www.ptc.com/support.

The FLEXnet license management software and installer program are in the
flex1m folder on the PTC Arbortext Advanced Print Publisher software DVD or
the license server download zip file available from the PTC Support site. Go to
Order or Download Software Updates and find PTC License Server: FLEXnet
Publisher. Choose the latest version of the download file for your system.

After the FLEXnet software is installed, it must be configured to recognize the
client computers as floating license clients. Consult the FLEXnet Licensing End
User Guide for license management configuration instructions.

For instructions on installing the PTC FlexNet License Server as either a single
server or a triad server, refer to the following suggested technique:

http://www.ptc.com/appserver/wems/standards/freefull cskdb.jsp?&im_dbkey=
90870&im_language=en

The PTC_D LICENSE_FILE Environment

Variable

PTC Arbortext Advanced Print Publisher automatically looks for the PTC D
LICENSE FILE environment variable when it starts. The variable should contain
either the path to your node-locked license file or the port@server specification
for the license server that can supply a floating license.

The variable is available in the User variables or System variables list on the
Environment variables tab of your System Properties dialog box.

Use one of the following values for PTC_D LICENSE FILE:
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» To reference a node-locked license file, set the value to the license file path,
For example: C: \User Data\All Users\Application Data\
Arbortext\lm 12345678 standard.txt

» To point to a single server supplying floating licenses, set the value to
port@servername. For example: 6789@aberdeen.

» To point to a triad server configuration, set the value to a comma separated list
of port@servername specifications. For example:

3456@able, 1345@baker, 3456C@charlie

* To use a combination of node-locked and floating licenses, set the value to
both the license file path and the port@servername specification of the
license server(s). Note that each type of license option is separated by a semi-
colon (;). For example:

C:\User Data\All Users\Application Data\Arbortext\lm 12345678
standard.txt;3456@able, 3456@baker, 3456Q@charlie

Refer to License Types on page 26 for a summary of license types.

Your system administrator may have deployed the licensing information to your
computer. In this case, you will never be prompted for this information unless you
encounter a licensing problem.

Refer to Troubleshooting Licensing Issues on page 32 for information on how to
resolve licensing issues.

Troubleshooting Licensing Issues

Here are some suggestions to assist with common licensing issues you may
encounter:

Unable to Obtain a License

PTC Arbortext users must have an active maintenance agreements, a PTC online
account and password, and a Host ID to get a license. Go to www.ptc.com/support
to obtain a license. See Obtaining Licenses on page 29 for further information.

PTC Arbortext products display a Licensing Error dialog box when they can’t find
valid license information. There is a wide variety of reasons that your software
can’t obtain a license:

» For node-locked licenses, the error message may report that the path to the
license file is not valid. If so, check the location of the license file and correct
the path if necessary.

» For floating licenses, the more common error messages may report that the
license server is down or that all licenses are in use. If so, wait a few minutes
then try again. If the problem persists, contact your system administrator.
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License information is stored in the PTC_D_ LICENSE FILE environment
variable (see The PTC_D LICENSE FILE Environment Variable on page 31 for
information). If it isn’t defined or its value is incorrect, the Licensing Error dialog
box will prompt you to enter the correct licensing information.

Problems Using a Node-Locked License

Check that you have defined the correct path for your license file. Locate your
license file and compare its location with the path specified in the Licensing Error
dialog box or the PTC_D LICENSE FILE environment variable.

Problems Using Floating Licenses

if you are unable to obtain a floating license from the license server, investigate
the following:

* Check that you have the correct port number and server name for the license
server (or three consecutive servers if your site is using a triad license server).
You may need to contact your system administrator to confirm the correct
information.

* Confirm with your system administrator that the license server is running.

« Ifyour site is using a triad license server, and the first license server goes
down, licenses might be unavailable for a few minutes until the back up
servers start distributing licenses. Wait for a few minutes then restart your PTC
Arbortext Advanced Print Publisher software. If you still receive the same
message, contact your system administrator.

Unable to Renew a Floating License

If your PTC Arbortext Advanced Print Publisher session is inactive for a long
period of time, the license manager may take back your license based on the
FlexNet license server’s TIMEOUT (ALL) configuration setting. If all configured
licenses are in use by other users when your resume your session, you will see an
error message. The system administrator should review the FLEXnet Licensing
End User Guide, which explains the TIMEOUT (ALL) setting, if this becomes a
problem.

A similar message might also appear if you are using a system in a remote
location and connected to the license server via a VPN or dial-up connection. You
may need to re-establish your connection before you can continue to use your
PTC Arbortext Advanced Print Publisher software.
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Configuring PTC Arbortext
Advanced Print Publisher —
Enterprise on Windows
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Instructions for changing the user accounts used by PTC Arbortext Advanced
Print Publisher — Enterprise Schedulers and Agents are included here. For other
configuration information, refer to PTC Arbortext Advanced Print Publisher —
Enterprise documentation, available from the APP-path\Docs\index.html
web page after you complete the installation.

You must have Administrator privileges to configure PTC Arbortext Advanced
Print Publisher — Enterprise Schedulers and Agents.
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Changing the Scheduler User Account

You can change the PTC Arbortext Advanced Print Publisher — Enterprise
Scheduler user account to a different user.

1.

Navigate to the Services console (Start » Control Panel » Administrative Tools
» Services).

Find the service named PTC Arbortext Advanced Print Publisher —
Enterprise Scheduler. Choose Properties and then Log On.

Choose This account and specify the domain user you want to assign. Provide
the password for the user you choose.

The user that you choose must have the right to log on as a service.

a. Navigate to the Component Services console (Start » Control Panel »
Administrative Tools » Component Services)

b. Under Component Services, navigate to Computers » My Computer >
DCOM Config.

c. Find the PTC Arbortext Advanced Print Publisher — Enterprise Scheduler.
Right click on it and choose Properties and then Security. Be sure the
account has full permissions.

Click OK to save your changes and exit.

Changing the Agent User Account

You can change the PTC Arbortext Advanced Print Publisher — Enterprise Agent
user account to a different user.

1.

36

Navigate to the Component Services console (Start » Control Panel »
Administrative Tools » Component Services).

Under Component Services, navigate to Computers » My Computer > DCOM
Config.

Find the agent named PTC Arbortext Advanced Print Publisher — Enterprise
Agent. Right click on it and choose Properties then Identity.

Choose This account and specify the domain user you want to assign. Provide
the password for the user you choose.

The user that you choose must have the right to log on as a batch job.

a. Navigate to the Component Services console (Start » Control Panel »
Administrative Tools » Component Services).

b. Under Component Services, navigate to Computers » My Computer >
DCOM Config.
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6.

c. Find the PTC Arbortext Advanced Print Publisher — Enterprise Agent.
Right click on it and choose Properties then Security. Be sure the account
has full permissions.

Click OK to save your changes and exit.

Providing Anonymous Permission for
Schedulers and Agents

If remote Agents fail to start and the Scheduler reports an error message that the
Scheduler was unable to start 3B2 in agent 'Remote’ because we failed to find out
from the Agent the 3B2 version, you may need to set ANONYMOUS LOGON for
remote access permission. On the Scheduler machine and the Agent machine, give
the anonymous user remote login access by following these instructions.

1.

Navigate to the Component Services console (Start » Control Panel >
Administrative Tools » Component Services).

Under Component Services, navigate to Computers » My Computer. Right
click on it and choose Properties.

Click the COM Security tab. Under Access Permissions, click the Edit Limits
button.

On the Security Limits tab, highlight ANONYMOUS LOGON. In the Permissions
for ANONYMOUS LOGON box, be sure Remote Access is checked.

Click OK to save your changes and exit.
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